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1 Introduction 

1.1 Product Overview 
The Qmini pushes the limits of miniaturization further: Within an amazingly small design, 
it delivers technical specifications that are unprecedented at this size. It is controlled and 
operated by the spectroscopy software “Waves“, which not only includes unique 
sophisticated algorithms for data acquisition and evaluation, but also provides these 
features through a clear and straightforward interface. Its compact design enables tight 
integration in applications where space is limited, like hand-held analysis devices. 

Qmini Hardware Features 

• Miniature design 
• Spectral resolution of 0.8 nm (across visible range) 
• High sensitivity and thermal stability 
• Optical input via SMA fiber connector or free focused beam (other options 

available) 
• 4 I/O channels for external triggering, light source control and general purpose I/O 
• Controlled and powered via USB 2.0 

Waves Software Features 

• Take and display series of spectra 
• Dynamic exposure control with dark spectrum interpolation 
• Import most ASCII-based file formats 
• Export as ASCII table to almost any numerical analysis software 
• Comprehensive tools for displaying and analyzing spectra 
•  “Strip charts“ for comparing characteristic values between multiple spectra 

including peak follower 
• Graph printing and export to PDF 
• Dynamic peak finder (no need to set a threshold level) 
• Automated wavelength calibration 
• Dark spectrum interpolation 
• Transmission, Reflection and Absorption measurements 
• Colorimetry 
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Applications 

• Color measurement 
• Chemical analysis 
• Quality control 
• System integration 
• Counterfeit detection 
• Environmental analysis 
• and many more 

1.2 System Requirements 
• Windows 8, 7, Vista or XP (32 or 64 bit) 
• .NET Framework Version 3.5 (available on the CD and as a free download) 
• USB 2.0 

1.3 Package Contents 
• Qmini spectrometer 
• USB cable 
• CD-ROM with Waves spectroscopy software including device driver, software 

development kit and this manual as PDF 
• Printed user manual 

1.4 Optional Accessories 
• I/O port adapter 
• IllumiCell cuvette holder with light source 
• Fiber optical cable 
• LightBox broadband light sources 

Visit us at www.rgb-laser.com if you need any accessories for your spectrometer. 
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2 Installation 

2.1 PC Setup 
Installing the Qwave spectrometer is very straightforward. You just need to install the 
software and then connect the device to a USB port. 

Please install the software by double-clicking on the WavesSetup.exe file on the CD-
ROM. The setup package then installs the application software and the device driver. For 
the operating system to properly recognize the device, it’s best if you install the software 
first before attaching the device. 

The software is tested with 32 and 64 bit versions of Windows 8, 7, Vista and XP. It 
requires the Microsoft .NET framework version 3.5, which is already installed on most PCs. 
If this framework is not installed, the setup package asks you to install it first. You can find 
the setup file for the .NET framework on the CD or download it from Microsoft’s website. 
Please note that you need version 3.5 of the framework. Version 4.0 does not include 
version 3.5. 

You can install the software on as many computers as you like. For example, you may 
want to install it in the lab for measurements and in your office for further spectrum 
analysis. If you don’t have the CD-ROM at hand, you can also download the software from 
our website. 

The device driver for the Qwave spectrometer is not fully certified yet. If Windows 
displays a warning, please choose to install the driver anyway. (If you received the 
software on CD-ROM with your spectrometer or downloaded it directly from our website 
www.rgb-laser.com, you can be assured that is does not contain any malicious software.) 

After the software is installed, please connect your Qwave spectrometer to a USB 2.0 port 
on the computer. You can use the provided USB cable or almost any other Mini-USB 
cable. The USB port needs to supply an electrical  current of 500 mA, so you need to 
either connect the spectrometer directly to your computer or to an externally powered 
USB hub. A flashing red LED on the device indicated that the port does not supply 
enough power. 

When you start the Waves software, it automatically searches for Qmini spectrometers 
and, if it finds one, initializes the device. If you attached it just before, it may take a few 
seconds before the spectrometer is properly recognized by the operating system. The 
initialization takes a couple of seconds during which the software loads the calibration 
data from the device. 

If the software finds no or several spectrometers while starting, it displays a dialog 
window from which you can choose a device or decide to use a “Simulated 
spectrometer” instead. This simulated spectrometer can be used to evaluate the software 
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without connecting an actual device. You can access this dialog window later on by 
choosing “Device Setup” from the File menu. 

2.2 Optical Setup 
The light enters the Qmini spectrometer through a 20 µm slit (other slits are available as 
custom modifications). You can see this slit if you look into the fiber optical connector on 
the front side of the device. 

If the light you wish to measure is quite strong, you may simply point the spectrometer 
towards it. For example, you can test the spectrometer by pointing it towards your 
computer screen or your desk light. 

In most cases, however, you’ll need a special optical probe to collect as much light as 
possible. In order to guide the light from the probe to the spectrometer, most users 
prefer a simple fiber optical cable with SMA connectors. Alternatively, you may also focus 
the light directly onto the entrance slit without fibers using your own optics. 

We recommend standard fiber optical cables with a core diameter of 200 µm and a small 
numerical aperture. If you’re using a fiber with a smaller diameter, you’ll get a slightly 
better resolution and sensitivity, but you may find it more difficult to focus the light into 
the fiber. If you’re using a larger fiber, the spectrometer cannot detect all of the light 
coming out of the fiber and the stray light is slightly increased. 

PLEASE NOTE: The calibration for the spectral sensitivity correction and the optical 
power was made with a 200 µm fiber optical cable. If you use a different fiber or 
especially if you just point the spectrometer towards the light source, the measured 
spectrum might not be accurate. If you have a calibrated light source, you can always 
recalibrate the spectral sensitivity for any optical setup (see chapter 3.9). 

If you focus the light directly onto the entrance slit, you’ll get the best sensitivity and 
lowest stray light if you make sure that: 

• The focused light is centered on the entrance slit, 
• the height of the light spot on the entrance slit is 200 µm or smaller and 
• the numerical aperture of your focusing optics is close to 0.1, matching the 

numerical aperture of the spectrometer. 

The Qmini spectrometer does not detect light from outside a cone that corresponds to a 
numerical aperture of about 0.1. Therefore, if your focusing optics has a larger aperture, 
you loose some intensity inside the spectrometer. On the other hand, numerical 
apertures significantly smaller than 0.1 may lead to a decrease in resolution. 
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2.3 Troubleshooting 

The green light on the spectrometer is off, the red light is flashing or lit 
continuously and the device does not react 

This indicates that the device has turned itself off because the USB port was not able to 
supply enough power. This also may happen if the USB cable is too long or damaged. 
Please disconnect the device and try a different USB port or cable. 

Waves cannot find the device 

Please disconnect and reconnect your spectrometer, close the “Device Config” window, 
wait a few seconds and open this window again from the File menu. If this doesn’t help, 
please restart your computer and try again. 

Please also check our website www.rgb-laser.com for software updates. 

If the software still cannot find the device, you may check the Device Manager in the 
Windows Control Panel. Your spectrometer should show up as “Qmini” in the “USB 
controllers” branch. If you double click on this list item and go to the “Driver” tab page, it 
should read: "Driver Provider: RGB Lasersysteme" and "Driver Version: 2.8.14.0" (or later). If 
your spectrometer is marked with an exclamation or question mark, please remove the 
device, uninstall the software from the Windows Control Panel, restart the computer and 
install the software again. 

If your spectrometer is not listed at all in the Device Manager, please try a different USB 
port. If the device does not work on one computer, but works on others, the USB port 
may not provide enough power for the spectrometer. In this case, you’ll need to use an 
externally powered USB hub. 

If this doesn’t help either, please contact our Technical Support Team (see chapter 5.1). 
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3 Operation 

3.1 Introduction 
Waves was designed from the ground up to provide a clean and straightforward user 
interface that does not stand in your way, without compromising advanced features or 
precision. 

If you are new to spectroscopy, you’ll find it easy to start using the software and taking 
spectra without having to worry about  details like calibration or dark spectra. 

If you already have experience with other spectroscopy software, you’ll notice a few 
differences: 

• There is just one mode of operation that includes all relevant types of 
measurements (absorption, irradiance, scope and so on) through a consistent and 
clear interface. 

• Waves favors a simple self-explanatory terminology instead of complicated terms 
that need to be explained. For example, we use “Exposure time” instead of  
“Integration time”, because the average user doesn’t really know what’s being 
integrated here. 

• There are no wizards to help you with complicated tasks, because wizards tend to 
conceal the actual task. We believe it’s better to make these tasks accessible 
through a clear and unified interface, so that you can understand what’s going on. 

3.2 Overview 
When you start Waves, the software searches for an attached Qmini spectrometer. If it 
finds one, it automatically initializes it. Afterwards, the software presents the main 
window: 
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The main window consists of several panels: 

1. The Exposure Toolbar, where you can start and stop taking spectra and set the 
acquisition parameters. 

2. The Spectrum List shows all spectra that are currently in memory. 
3. The Properties Panel consists of four tab pages and displays many parameters and 

values of the spectrum currently selected in the Spectrum List. 
4. The Main Diagram Panel shows all spectra marked with a check mark in the list. 
5. The Display Parameters Panel determines how the spectra are displayed. 

In order to get more screen space for the main diagram, the other panels can be 
minimized by clicking on the buttons with two triangles next to the panel title. 

3.3 Taking Spectra 
In order to take a spectrum, just choose an exposure time or select auto exposure and 
click on one of the green buttons ([ ] for a single shot or [ ] to start a continuous 
measurement). You can increase the exposure time in order to decrease the noise level. If 
the amount of light detected during the exposure is too large for the CCD detector inside 
the spectrometer, the spectrum appears saturated and a red “OVERLOAD” warning 
appears at the top of the diagram. In this case, you need to decrease the exposure time. 
You can further increase the sensitivity by averaging across multiple exposures with the 
“Temporal Averaging” setting. 

If a spectrum acquisition takes longer than one second, you can monitor the progress in 
the status bar at the bottom of the window. The acquisition may finish before the 
progress indication reaches the end position, because the spectrometer is triggering on 
the end of the exposure period (see chapter 3.10 for details). You can stop the data 
acquisition by clicking on the red stop button [ ]. 

If you choose auto exposure, the exposure time for each new spectrum is set 
automatically based on the intensity of the previous spectrum. It may take a few spectra 
before the auto exposure control has reached its optimum. In auto exposure mode, you 
can set a maximum exposure time in order to prevent very long exposure times in cases 
when there is simply no signal. 

Spectra can be taken with or without spectral sensitivity correction (see chapter 3.9 for 
more details). If the lightmeter button [ ] is selected, the spectral sensitivity of the 
spectrometer is automatically corrected and the intensity axis is measured in nW/nm. 

PLEASE NOTE: If you take a spectrum with spectral sensitivity correction, the noise in the 
spectrum is not evenly distributed, because some parts of the spectrum are more 
amplified than others. On the other hand, if this button is not selected, the spectral 
sensitivity is not corrected and the intensity axis displays values as they are produced by 
the spectrometer hardware. In this case, you may find an uneven distribution of the 
sensitivity across the spectrum. For precise measurements, it is recommended to turn on 
spectral sensitivity correction. 
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Dark spectra for the spectrometer are stored in the device and used automatically when 
taking spectra (see chapter 3.9 for details). If you have background radiation, you can 
compensate for it by taking a background spectrum (see chapter 3.8). In the Exposure 
Toolbar you can also select the triggering mode (see chapter 3.10) and choose a 
reference spectrum for absorption, reflection and transmission spectroscopy (see chapter 
3.8). 

3.4 Spectrum Display 
The Main Diagram Panel displays all spectra that are marked by a check mark in the 
Spectrum List. If no spectrum is checked in the list, then the currently selected spectrum 
(marked by a gray bar) is displayed. You can check and uncheck all spectra at once by 
clicking on the corresponding button [ ] or [ ] on top of the Spectrum List.  

The peaks in the spectra are automatically determined. This not only works pretty reliable 
for clearly defined peaks, but also for those lying in the side of another peak or those that 
are just above the noise level. If necessary, you can fine-tune the parameters for finding 
the peaks by choosing “Peak Finder Parameters” from the Tools menu. In this window 
you can choose three settings: 

•  “Absolute threshold” determines how much a peak must be above the noise level 
in order to be considered as a peak. 

• “Relative threshold” describes how large a peak must be compared to the local 
minima before and after it in order to be considered as a peak. 

• “Position threshold” determines how much of the top part of the peak is 
considered when calculating the peak position.  

Peak positions and widths are only displayed for the currently selected spectrum. The 
peak positions, heights and widths are also displayed in the Properties Panel and can be 
exported by choosing “Export Peaks” from the File menu. 

In the Display Parameters Panel below the diagram you can select how the spectra are 
displayed. These settings affect the diagram display, but do not modify the actual data. 
Here you can change the scaling of both axes, the unit of the wavelength axis, turn the 
display of the grid, peak positions and peak heights on and off and see the coordinates of 
the current position of the mouse pointer. 

If you zoom into the wavelength axis, a scrollbar appears at the bottom of the diagram  
for easily moving the displayed part of the spectrum. Alternatively, you can grab and 
move the axis with the mouse. You can also drag the intensity axis in order to change the 
maximum value and quickly enlarge weaker parts of the spectrum. 

If you would like to determine the intensity value at the position of the mouse pointer 
relative to a reference value, just move the mouse to that reference value, click with the 
right mouse button and choose “Set reference level”. 

You can select a single wavelength or a range of wavelengths by clicking or clicking and 
dragging in the diagram. This selection can be used to compare wavelength values, to 
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display statistical data just for the selection (see chapter 3.5) and to zoom into it (by right-
clicking). 

3.5 Working with spectra 
In Waves, you can have several spectra loaded at the same time for easy comparison and 
analysis. On the upper left side you can see the Spectrum List. Whenever you take a new 
spectrum, it appears in this list as “current spectrum” and overwrites any previous 
“current spectrum”. If you would like to keep this spectrum and take another one, just 
click on the single push pin button [ ]. This prevents the current spectrum from being 
overwritten. A new spectrum you take is then appended to the list. Giving the “current 
spectrum” a new name also prevents it from being overwritten. You can also choose to 
keep all new spectra by selecting the button with multiple push pins [ ] in the Exposure 
Toolbar. 

When you have multiple spectra in the list, one spectrum is always selected (marked by a 
gray bar). All metadata and additional information for this spectrum is displayed in the 
Properties Panel on the lower left side. The Properties Panel has five Tab pages: 

• General: Displays spectrum metadata. “Name” corresponds to the name in the 
Spectrum List.  “User” is automatically set to the current Windows user name, but 
can be changed. “Sample”, “Light” and “Comments” can be freely edited by the 
user.  You can change the color of the spectrum by clicking on the color box. Please 
note that “User”, “Sample”, “Light” and “Comments” is the same for all spectra in 
the list. 

• Values: Displays statistical values both for the whole spectrum and within the 
selection (if you have selected a range of wavelengths in the diagram). 

• Color: Displays colorimetric values. For precise color measurements please also 
read the section on calibration accuracy in chapter 3.9. 

• Peaks: Displays peak positions, heights and widths. This list can be save to a file by 
choosing “Export Peaks” from the file menu. 

• Data: Displays a list of all values of the spectrum. 

Some of the values in the Properties Panel are saved when saving the spectrum to a file. 
The others are recalculated when the spectrum is reloaded. 

3.6 File Operations 
You can save the selected spectrum or the whole Spectrum List using the commands in 
the File menu. You can also open spectrum files to load them back into Waves for further 
evaluation (sounds obvious, but surprisingly, many spectroscopy applications don’t even 
support this). 

The file format for spectra is a simple ASCII table with columns delimited by the TAB 
character and some header lines containing the metadata. This allows the spectrum files 
saved by Waves to be read by almost any numerical analysis software like Origin, Excel or 
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Matlab. The default file extension for these files is “.spz”. If you click on an .spz file in 
Window Explorer, it is opened with the Waves application. 

In Waves, you can also open spectrum data files written by other applications, if they are 
saved as ASCII tables or .csv files. Waves tries its best to automatically determine the file 
structure and is able to open many different file formats.1 

You can print spectra by choosing “Print” from the file menu. If you choose the page 
orientation as “Landscape”, the spectrum diagram is printed across the whole page. If 
you choose “Portrait”, the diagram is printed on the upper half of the page and the lower 
half shows selected metadata and values. 

The printing options are designed for the most common tasks. If you have further specific 
requirements for printing, you may also decide to export the diagram and then use a 
graphical design software or word processor for printing. 

You can export the diagram either as a bitmap image or as a PDF vector graphic. Both 
options are available by choosing “Export” from the File menu. 

After choosing a file name, you can set the height and width of the image and the 
resolution, if applicable. Please note that the text sizes and line widths are constant. 
Therefore, if you choose a larger export size, the labels and line widths appear to be 
smaller. 

3.7 Spectrum Analysis 
The Analysis menu offers several ways to evaluate and modify spectra: 

Adjust Offset 

This adds a constant value to all data points of the selected spectrum. The software 
suggests a estimated value for compensating an offset, but you may also choose any 
other value. 

Normalize 

This multiplies all data points of the selected spectrum by a constant factor. The default 
factor is chosen for the maximum value to be scaled to 100. 

Differentiate 

This differentiates the spectrum with respect to the wavelength. 

                                                                            
1 In case you have a spectrum file written as ASCII data and you are unable to  open it in Waves, please 
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Spectral Averaging 

This substitutes each data point by the average of the surrounding data points. You can 
choose how many data points to include in the averaging. This is also known as “Boxcar 
Averaging”. 

Arithmetic Operations 

This create a new spectrum by adding, subtracting, multiplying or dividing two spectra. 

Adjust Wavelength 

This allows to assign a new wavelength scale to all spectra in the list based on the 
parameters for the fourth-order polynomial function used for wavelength calibration. It 
may be useful if you took spectra with an incorrect wavelength calibration. 

Duplicate 

This creates a copy of the selected spectrum and may be useful if you would like to 
modify a spectrum, but also keep the original one. 

Peak Width Diagram 

This opens a window displaying the widths of the detected peaks (Full width at half 
maximum). 

Show Strip Chart 

You can use the Strip Chart window to display a characteristic spectrum value as a 
function of another value for all spectra in the list. The most common task is to display 
the temporal evolution of a characteristic value. This window can be kept open while 
taking new spectra to see the changes as they happen. 

In the lower left side of the Strip Chart window, you can choose which values to assign to 
the x and y axis of the chart. You can choose all numerical values that are displayed in the 
Properties Panel in the main window. If you want to view the temporal evolution of a 
value, choose this value for the y axis and either “Number in List” or “Time” for the x axis. 

If you choose “Value from name” as x or y axis, the software tries parse the name of each 
spectrum into a number. So for example, if you have a list of spectra that are named “T = 
10.3 °C”, “T = 15.2 °C” and so on and you choose “Value from name”, these temperature 
value are used for the corresponding axis. 

In the Strip Chart diagram, the currently selected spectrum is marked by a slightly larger 
point. Points corresponding to spectra that are currently not visible in the main window 
are draw in a lighter red color.  
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Show Loupe 

This opens a window with a magnified display of the spectrum around the mouse 
pointer. It may be used in order to study small features in the spectrum as an alternative 
to zooming in. 

3.8 Absorption, Reflection and Transmission Measurements 

Principle 

In absorption, reflection and transmission spectroscopy you direct light from a 
broadband light source onto a sample. Then you take a spectrum 𝐼(λ) of the light that is 
transmitted through or reflected from the sample. In order to get meaningful results that 
are independent of the light source, you also take a spectrum of the light source 𝐼!(λ)  as 
a reference. 

The spectral transmittance 𝑇 λ  or reflectance is then simply the fraction of transmitted 
or reflected light: 

𝑇(λ) =   
𝐼(λ)
𝐼!(λ)

  	
  

This formula gives values in the range between 0 and 1. The transmittance is usually 
written as a percentage. The spectral absorbance 𝐴 λ   is defined as: 

𝐴 λ = log
𝐼!(λ)
𝐼(λ)

	
  

Please note that the absorbance is sometimes defined as the base 10 logarithm and 
sometimes as the natural (base e) logarithm. In Waves, you can choose in the Options 
window from the File menu which logarithm to use. 

Measurement 

In order to measure absorption, reflection or transmission you need to take a reference 
spectrum of the light source first. If your measurement setup is not in complete darkness, 
it is also generally recommended to take a background spectrum before the 
measurement. 

To take a background spectrum, turn off the light source, set an appropriate exposure 
time and click the “Take Background Spectrum” button [ ] on the Exposure Toolbar. In 
order to minimize noise, you may also want to use temporal averaging. When you’ve 
taken a background spectrum, you can select the “Use Background Spectrum” button [ ]. 
If you take a spectrum afterwards, the background spectrum is automatically subtracted 
from the measured spectrum, eliminating unwanted background signals. 
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To take a reference spectrum for transmission or absorption spectroscopy, turn on the 
light source again, remove the sample, set an appropriate exposure time and temporal 
averaging and click the “Take Reference Spectrum” button [ ]. After selecting the “Use 
Reference Spectrum” button [ ], you can take spectra of your sample for measuring 
absorption or transmission. 

To take a reference spectrum for reflection spectroscopy, you need a white reference 
sample to calibrate the setup for 100 % reflection. However, all real-world reference 
samples have a reflection of less than 100 % and an uneven spectral distribution. 
Therefore, for accurate measurements you also need to supply a reference spectrum for 
your reference sample. To take a reference spectrum, place the white reference sample 
where you’ll later place the sample to be measured. Then set an appropriate exposure 
time and temporal averaging and click the “Take Reference Spectrum” button [ ]. In the 
following dialog window, you can also specify a data file that includes a calibrated 
spectrum of your reference sample. After selecting the “Use Reference Spectrum” button 
[ ], you can measure reflectivity spectra. 

The y axis of the spectrum now shows the relative intensity of the measured spectrum 
compared to the reference spectrum. In the “Options” dialog from the File menu you can 
choose different units for displaying the spectra: 

• Ratio shows the ratio of the measured spectrum to the reference spectrum as in 
the formula for 𝑇 λ  above. 

• Percentage shows the same value 𝑇 λ , but written as a percentage (i.e. multiplied 
by 100).2 This unit is usually used for transmittance. 

• Absorbance shows the spectral absorbance 𝐴 λ  according to the formula above. 
You can choose between natural and base 10 logarithm. 

These options only determine how to display the spectra in the diagram. The do not 
modify the actual spectrum data. 

If your light source does not cover the full range of the spectrometer, the calculated 
spectrum may show large amounts of noise outside of the wavelength range of your 
light source. This is normal and reflects the fact that the measurement has a large 
uncertainty at these wavelengths. 

These measurements are quite sensitive to changes of the sample illumination. If in 
doubt, you may want to take another reference spectrum to check if it is still valid. 

3.9 Calibration 
The calibration for the wavelengths, dark spectra and spectral sensitivity are stored on 
the device and loaded automatically during device initialization. So in contrast to almost 
any other spectroscopy software, you don’t need to worry about taking dark spectra and 
other calibration parameters, it’s all done automatically. 

                                                                            
2  Please note that „percent“ means nothing else than “divided by 100”. 
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If the device has been used for a long time or if you need a very precise measurement, 
you can easily recalibrate the spectrometer within Waves, if you have a suitable light 
source. Recalibration may also be required if the device temperature is outside of the 
calibrated temperature range. The device temperature is continuously monitored by the 
spectrometer and a warning is displayed, if the temperature has changed considerably. 

After you have recalibrated the spectrometer, you can always restore the factory 
calibration in the “Device Properties” window from the File menu. 

Calibration Accuracy 

The wavelength calibration is very accurate and changes only little with time or 
temperature. Therefore, most users won’t ever need to recalibrate the wavelengths. 

The dark spectrum calibration depends on the temperature. If the temperature has 
changed considerably, a warning message is displayed recommending recalibration. 
However, if in doubt or if you need as little noise as possible, you can always easily 
recalibrate it because no calibration light source is required. 

The calibration for the spectral sensitivity depends a lot on your optical fiber, your 
measurement probe and how the light is coupled into the spectrometer. During 
production of the Qmini spectrometer, we don’t know what your optical setup is going to 
be. Therefore the factory calibration for the spectral sensitivity and especially the 
absolute intensity is not to be considered as a precise measurement, but rather as a first 
estimate. If you require precise intensity measurements, you’ll have to recalibrate the 
sensitivity of the whole system including fiber and probe. 

In addition, please note that after changing the exposure time, it takes a few spectra 
before the CCD sensor inside the spectrometer reaches its new equilibrium. This means 
that after changing the exposure time, the intensities of the following 5 to 10 spectra 
may not be as accurate as later measurements. Therefore, for precise measurements we 
recommend not to use the auto-exposure feature and to set a fixed exposure time 
instead. 

Wavelengths 

The mapping of the individual pixels of the spectrum to wavelengths is done using a 
third-order polynomial. The four parameters for this function are measured during 
manufacturing and stored in the device. Usually, this wavelength calibration does not 
change. Therefore, in most cases you don’t need to recalibrate the wavelengths. 
However, if the ambient temperature has changed substantially, if the device has been 
used for a very long time or if you just would like to make sure that the wavelengths are 
really correct, you can recalibrate the wavelength if you have a suitable light source with 
several sharp atomic emission lines. These wavelength calibration sources are usually 
low-pressure gas discharge lamps filled with Krypton, Neon, Mercury, Argon or Xenon 
gas. 



Operation 

 15 

To recalibrate, take a spectrum of this light source first. Make sure that the relevant peaks 
are automatically detected. If not, adjust the “Peak Finder Parameters” in the Tools Menu. 
Then choose “Calibrate Wavelengths” from the Tools menu. In the “Reference Spectrum” 
combo box select the type of light source used. If you don’t find your light source in the 
list, you need to supply your own calibration lines. In this case, please take a look at the 
“CalibrationLines	
  xxx.dat” files in the installation folder on your hard drive and 
create a new similar file containing the spectrum lines of your light source. 

After you have selected your light source, click on “Start Fit”. The software tries to match 
the peaks in the measured spectrum and the given spectrum lines for your light source 
automatically. Not all of the given spectrum lines have to be present in the measured 
spectrum, but all measured peaks must be known spectrum lines. If a match has been 
found, the average deviation is displayed. If the match seems to be successful, it is 
displayed in green, otherwise in red. You can also graphically display the deviations by 
clicking on “Show Deviations”. If the measured peaks have successfully been identified, 
you can set the four new wavelength calibration parameters by clicking on the “Save” 
button and confirm by clicking “OK”. The new wavelength calibration is then saved to the 
device. 

Dark Spectra 

Inside the Qmini spectrometer, the spectra are detected with a CCD line sensor. Like all 
image sensors, this sensor detects a small signal even if there is no light entering the 
spectrometer. This signal depends on the individual pixel, the exposure time and the 
temperature. In order to obtain a precise measurement with a small noise level, this “Dark 
Spectrum” must be taken while no light enters the spectrometer and then subtracted 
from the actual measurement. 

For your Qmini spectrometer, this dark spectrum has already been taken, is stored in the 
device and automatically subtracted from the measured spectrum each time you take a 
new spectrum. Because the dark spectrum depends on the exposure time in a non-linear 
way,  there are actually multiple dark spectra stored in the device for a certain number of 
exposure times. The dark spectrum that is needed for a chosen exposure time is then  
obtained by interpolating between these dark spectra. 

In case you find that the spectra you get are not zero on the average, even if no light 
enters the spectrometer, then you probably need to recalibrate the dark spectra. You can 
also check the dark spectrum calibration using the “Calibrate Dark Spectrum” window 
(see below). 

To recalibrate the dark spectra, simply close the spectrometer entrance, make sure that 
no light enters the device and choose “Calibrate Dark Spectrum” from the Tools menu. 
Then click the “Take” button and go for a coffee. After a few minutes the software has 
taken dark spectra for a series of exposure times. You can check the new dark spectra by 
clicking on the “Test Button”.  While the test is running, you can in the lower diagram the 
spectra taken without (red) and with (green) dark spectrum correction. In the upper 
diagram you can see the noise level, also without (red) and with (green) dark spectrum 
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correction for a series of exposure times. You can see that the noise level of the raw data 
(red) increases significantly with increasing exposure time. With dark spectrum correction 
(green) however, the noise level should remain pretty much at the same level for 
exposure times less than 1 second and increase slower for exposure times larger than 1 
second. If you find this to be the case, close the window by clicking on the “OK” button 
and the new dark spectrum calibration is saved into the device.  Otherwise you may 
calibrate again or click “Cancel”. 

Spectral Sensitivity 

Like in all spectrometers, the sensitivity of the Qmini spectrometer is not uniform across 
the spectrum, but depends on the wavelength. This is called “Spectral Sensitivity” and 
can be corrected by dividing each value of the spectrum by the corresponding sensitivity. 
This sensitivity calibration is also stored in the device. However, it is not always used 
when taking spectra, because if the sensitivity is corrected, the noise level is unevenly 
distributed across the spectrum. Instead, you can choose to use the spectral sensitivity 
correction by selecting the “lightmeter” button in the Exposure Toolbar. 

If you would like to recalibrate the spectral sensitivity, you need a light source with a 
continuous spectrum (like a tungsten halogen lamp) and a calibrated spectrum for this 
lamp. 

To recalibrate, take a spectrum of your light source with spectral sensitivity correction 
turned off. Make sure the spectrum contains as little noise as possible by using a strong 
light source, a suitable exposure time and use Temporal Averaging. Then choose 
“Calibrate Spectral Sensitivity” from the Tools menu. Click on the “Load reference data” 
button to load the calibrated reference spectrum (in other words: a spectrum file that 
shows how your light source really looks like). Based on the measured spectrum and this 
file, the software calculated the spectral sensitivity of your spectrometer and shows it as a 
dark green line. To save this new calibration to the device, click “OK”. 

If you also want to calibrate the absolute scale of the intensity axis, you need to take a 
spectrum and also need to know the absolute optical power (in Watts) of this spectrum. If 
you measure the actual optical power with an optical powermeter, please make sure that 
the powermeter only detects wavelengths that are within the wavelength range of your 
spectrometer (for example by choosing a suitable light source). Then choose “Calibrate 
power” from the Tools menu and enter the actual power. If you click “OK”, the new power 
calibration is stored in the device and used for scaling the intensity axis. This axis then 
displays the spectral power density in nW/nm. 

In addition, you don’t have to calibrate the power at the spectrometer entrance. For 
instance, you could calibrate the power that enters your measurement probe or any 
other power in your setup, as long as it is proportional to the power that enters the 
spectrometer. Just remember that the optical powers and power densities displayed by 
the software refer to this value. 
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3.10 Triggering and I/O Port 

Trigger Options 

Spectra are generally taken after you click on one of the green buttons ([ ] or [ ]) in the 
Exposure Toolbar. In addition, you can set the spectrometer to wait for an additional 
event before taking a spectrum. This is called “Triggering”. In the Exposure Toolbar, you 
can select one of three different trigger modes: 

• continuous: Spectra are taken as soon as possible. 
• interval: Spectra are taken in regular time intervals. You can specify the time 

between two spectra and also a time period after which the measurement is 
stopped. The timer progress is shown in the status bar. Obviously, this trigger 
mode does not apply to single shot measurements. 

• external: Spectra are taken after the input voltage on one of the external I/O 
channels has changed. You can use this to synchronize the exposure to other 
devices or external events. 

On the “Configuration” tab in the “Device Properties” window you can select further 
trigger options. These trigger options apply to the external as well as to the internal 
(continuous and interval) trigger modes. 

• Trigger on end of exposure: This is the default mode. The spectrometer is 
continuously taking spectra and when the trigger event occurs, the current 
spectrum is read out. This causes a random trigger delay between zero and the 
exposure time. 

• Trigger on start of exposure: The spectrometer is continuously taking spectra and 
when the trigger event occurs, the next spectrum after the one currently being 
taken is read out. Choose this mode if you need to make sure that no light is 
collected for the spectrum before the trigger event occurs or before you click the 
button. This mode requires more time to take a spectrum. It also causes a random 
trigger delay between zero and the exposure time. 

• Trigger on start of exposure with low-jitter mode: The spectrometer is 
continuously taking spectra with a very short exposure time of 50 µs and when the 
trigger event occurs, a new spectrum is started with the selected exposure time. 
This causes a trigger delay of less than 50 µs. However, in this mode the accuracy of 
the intensity values is reduced. Therefore, only use low-jitter mode if your 
application really requires it. In this mode the CCD sensor has different dark signal 
properties. Therefore, when turning low-jitter mode on or off, it is recommended to 
take a new set of dark spectra. 

For external triggering, there are a few more options described below. 
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I/O Channels 

The Qmini includes an I/O port on the front side with 4 channels that can be configured 
as general-purpose I/O pins, for light source or shutter control or as trigger input. You can 
configure the channels by choosing “Show Device Properties” from the File menu and 
then going to the “Configuration” tab page. Please see chapter 6 for the pin assignment 
of the external connector. 

In order to use a channel as an external trigger source, please: 

• Set this pin to “Input” 
• Set the trigger pin number 
• Select either Falling Edge (trigger occurs when the input voltage drops from 5 to 0 

V) or Rising Edge (trigger occurs when the voltage rises from 0 to 5 V).  
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4 Software Development Kit 
The CD-ROM also includes a Software Development Kit (SDK) for the Qmini spectrometer 
that can be used to control the spectrometer and take spectra from your own custom 
software. It includes a Windows Dynamic Link Library (DLL) for the .NET framework, 
documentation and sample code. 

4.1 Prerequisites 
The system requirements are the same as for Waves (see chapter 1.2). 

You can use the Qmini SDK with any programming language that can connect to .NET 
DLLs. This includes C#, Visual Basic .NET, C++/CLI, Delphi, LabView, Matlab and 
Mathematica. If you are using a programming language that can connect to COM, but 
not to .NET libraries, you may need to use Microsoft’s Assembly Registration Tool 
(Regasm.exe). 

You should have a basic understanding of the concepts of object-oriented programming 
in order to understand the structure and functionality of the SDK library. 

4.2 Getting started 
In order to get familiar with the SDK quickly, we suggest to: 

1. Read the next chapter 4.3 to understand the structure of the SDK library. 
2. Read the basic steps required in order to take a spectrum (chapter 4.5). 
3. Study the sample projects included in the SDK. 
4. Add the SDK library to your own project (chapter 4.4). 
5. Implement the basic functionality of taking a spectrum in your project. 
6. Implement advanced features as required. 

4.3 Classes Overview 
The SDK library contains classes for controlling a spectrometer or laser as well as abstract 
base classes for various types of measurement and control devices. 

The main class that you need in order to communicate with the spectrometer is: 
          RgbSpectrometer	
  
              which is a descendant of the ExtendedSpectrometer class, 
                  which is a descendant of the Spectrometer class, 
                      which is a descendant of the Device class. 
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The Device class includes basic features used by all kinds of measurement and control 
devices. Spectrometer is a base class for a simple spectrometer. 
ExtendedSpectrometer	
   is a base class for a spectrometer with more features. 
RgbSpectrometer implements all the features specified in the abstract base classes in 
order to control a Qmini spectrometer. 

The library also includes the SimulatedSpectrometer class, that may be used instead 
of RgbSpectrometer to test your software in case you don't have a real device available, 
just like choosing “Simulated Spectrometer” in Waves. However, this class is currently 
only a descendant of the Spectrometer class and does not support the additional 
features in ExtendedSpectrometer. 

You can find the full documentation for all relevant classes in the SDK documentation 
contained in the RgbDriverKit	
  documentation.chm help file. 

4.4 Adding the SDK library to your project 
The main library to connect to your spectrometer is in the RgbDriverKit.dll file. 
Please copy it to your main project folder. The Qmini device driver for Windows, which is 
installed during the installation of Waves, must also be present. 

Visual Studio 

If you are using one of Microsoft’s languages, please add both libraries in Visual Studio to 
your project references (in the Solution Explorer window). Then import the 
RgbDriverKit library to your source code files (for example in C# or C++: “using	
  
RgbDriverKit;”). For enhanced IntelliSense support in Visual Studio, you may also 
want to copy the RgbDriverKit.xml file into the same folder as the library. 

LabVIEW 

In order to use a .NET DLL in LabVIEW, you need to: 

• Use the .NET palette (Connectivity -> .NET) to find all of the functions available. 
• Use a constructor node in order to instantiate a class within the .NET assembly. 
• Use property nodes and invoke nodes to access properties and methods of the 

class by wiring in the class reference from the constructor node to the property or 
invoke node. 

Specific LabVIEW VIs for controlling the Qmini spectrometer are planned for a later 
release of the SDK. 

Other languages 

For more information on how to connect to the library from other programming 
languages, please try a Google search for something like “use .NET DLL in [your 
language]”. 
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For example, users of Matlab may find useful information at: 
http://www.mathworks.de/help/techdoc/matlab_external/brpb5k6.html 

4.5 Taking a spectrum 
First you need to instantiate an RgbSpectrometer object to control your spectrometer. 
You could use the class constructor, of course, but in most cases it’ll be easier to search 
for spectrometers by calling the static SearchDevices() method and then choose from 
one of the returned objects, which are actual instances of the RgbSpectrometer class. 

Then, the steps required for taking a simple spectrum are: 

1. Open the connection to the device using the Open() method. 
2. If you need the wavelengths, get an array containing the wavelengths of each 

pixel with GetWavelengths(). 
3. Set the exposure time using the ExposureTime property. 
4. Start the exposure with the StartExposure() method. 
5. Wait (or do something else) while the Status property is 

SpectrometerStatus.TakingSpectrum. 
6. Read the spectrum with the GetData() method. 

The full documentation for these methods and properties can be found in the 
RgbDriverKit	
  documentation.chm help file. 

All methods and some properties may throw an exception as described in the SDK 
documentation help file. Always make sure that these exceptions are properly handled 
by placing these methods inside a try{}	
  catch{} block. 

4.6 Deploying your project 
If you would like to deploy your project to other users, please: 

• Include the DLL file RgbDriverKit.dll. 
• Make sure that the .NET framework 3.5 is installed. 
• Make sure that the Qmini device driver is installed. 

The device driver is normally installed during the installation of Waves. If you would like 
to use the spectrometer without installing Waves, you can find the files for the device 
driver in the “Qwave driver” folder in the program folder of a Waves installation. 
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5 Technical Support 

5.1 Getting Help 
If you have any questions, comments or requests concerning your Qmini spectrometer or 
the Waves software, please go to 

http://www.rgb-­‐laser.com	
  

and click on “Support” on the menu bar. 

There you’ll also find details on how to contact our Technical Support Team via e-mail or 
telephone. 

5.2 Software Updates 
Software Updates are expected to be released about twice a year. To check for updates, 
you can choose “Check for Updates” from the Help menu or go to the “Support” section 
on our website www.rgb-laser.com. 

These are some of the features planned for future software releases (subject to change): 

• More colorimetry values and options 
• Trigger on beginning of exposure 
• External shutter and light source control 
• Sensor nonlinearity correction 
• More options for printing and export 
• Working with multiple spectrometers 
• More spectrum analysis features 
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6 Specifications 

Optical 

Focal length: 50 mm 
Numerical Aperture: 0.10 
Grating: 600 lines/mm 
Entrance slit: 20 µm 
Spectral resolution (FWHM): 0.8 nm 
Stray light: < 0.1 % 
Optical interface: SMA connector 

Electronic 

Dynamic range: 500 : 1 (full scale, texp = 1 s) 
Detector: 2500 pixel linear CCD detector 
A/D converter: 16 bit 15 MHz 
Calibration: Wavelength, sensitivity and multiple dark spectra stored 
 within device 
Transfer speed to PC: 70 ms per spectrum 
Digital Interface: USB 2.0 
Extension port: 4 General purpose I/O channels 
 Configurable as trigger input 
 Digital interface for accessories 
Power supply: 5 V DC via USB (no power adapter required) 
Power consumption: typical: 180 mA, maximum: 500 mA (with accessory) 
PC operating system: Windows 8, 7, Vista, XP 

Mechanical 

Dimensions: 62.0 × 42.0 × 14.8 mm 
Weight: 57.5 g 
Operating temperature: -15°C to 60°C (non-condensing) 
Storage temperature: -25°C to 70°C 
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Technical Drawing 

 
  

All dimensions in mm. 

3D CAD files are available for download on www.rgb-laser.com. 
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Pin Assignment 

 

Pins 4, 5 and 6 are only present on the square connector on the device and intended for 
communication with optional accessories. Please do not use these pins. 

All other pins are also present on the optional I/O port adapter. Use these pins for trigger 
input and general-purpose I/O. You can use the power supply on pin 1 to supply small 
custom electronics. 

1: + 5 V Power Supply (max. 300 mA) 

2: I/O Pin 0 

3: I/O Pin 1 

4: Extension Present (for accessories) 

5: Digital Interface SCL (for accessories) 

6: Digital Interface SDA (for accessories) 

7: I/O Pin 2 

8: I/O Pin 3 

9: Ground 

 

1 4 7 

2 5 8 

3 6 9 

 

Qmini Extension Port 

(Connector viewed towards 
front side of device) 

1 2 3 7 8 9 

 

       
I/O Port Adapter 

(Screw terminal block viewed 
towards front side of device) 
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7 Certifications and Compliance 
 

 

 

 

CE Declaration of Conformity 

 
The manufacturer 
 
  RGB	
  Lasersysteme	
  GmbH	
  
	
  	
   Donaupark	
  13	
  
	
  	
   93309	
  Kelheim	
  
 
declares that the following product 
 
  Qmini	
  	
  	
  	
   Version	
  1.0	
  
 
complies with the following normative documents 
 
  EN55022:	
  2010	
  
 EN61000-­‐6-­‐2:	
  2005 
 
and therefore with the following EG requirements 

 

 Electromagnetic	
  compatibility	
  (2004/108/EG) 

 
This declaration applies to all models of the above named product 
version, in case it will be used in the configuration of the test 
assembly. 
 
 
Kelheim, 17.11.2012    Mathias Reichl 

 


